
It’s time to do some work with your 
own videos. You’ve heard of garbage 
in, garbage out? !at truism also 
applies to video editing. So, your "rst 
task is to shoot some great looking 
video. !en use Premiere Pro 2.0 to 
capture that video—transfer it from 
your camcorder or VCR to your PC’s 
hard drive. Premiere Pro o#ers several 
ways to do that. Each is easy and fast.
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Topics covered in this lesson:

• Twenty tips for shooting great video.
• Advice from a TV-news chief photographer.
• Capturing an entire videotape.
• Using batch capture and scene detection.
• Tackling manual analog video capture.

Getting started
!e purpose of this book is to help you use Premiere Pro to make 
professional-looking videos. To do that you need to start with high 
quality raw material. So in this lesson I give you my top 20 tips 
for shooting great video. I call on a friend who is a TV-news chief 
photographer to pony up his advice. And I show you four methods 
to transfer or capture your video to your PC. !is is the "rst lesson 
to address Adobe Certi"ed Expert exam objectives. I point them out 
as we encounter their applicable topics.

Shooting and Capturing 
Great Video Assets
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Twenty tips for shooting great video
With your camcorder of choice in hand, it’s time to venture o# and shoot videos. If you’re 
new to videography, following these tips will help you create better videos. If you’re an 
old hand, think of this list as a way to snap out of your routine and juice things up a bit. 
Here are my shooting axioms:

• Get a closing shot
• Get an establishing shot
• Shoot plenty of video
• Adhere to the “rule of thirds”
• Keep your shots steady
• Follow action
• Use trucking shots
• Find unusual angles
• Lean forward or backward
• Get wide and tight shots
• Shoot matched action
• Get sequences
• Avoid fast pans and snap zooms
• Shoot cutaways
• Don’t break the “plane”
• Use lights
• Grab good “bites”
• Get plenty of natural sound
• Stripe your tapes
• Plan your shoot
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Get a closing shot
Your closing images are what stick in people’s minds. You should be constantly on the 
lookout for that one shot or sequence that best wraps up your story.

NBC-TV feature reporter Bob Dotson and his photographer never fail to "nd a closing 
shot. It could be as simple as someone closing a door, capping a pen, petting a dog, 
turning out the lights, or releasing a butter$y from their cupped hands. If you happen to 
see a Dotson feature story, consider its close. It’s sure to be memorable.

Get an establishing shot
An establishing shot sets a scene in one image. Although super-wide shots work well 
(aerials in particular), consider other points of view: from the cockpit of a race car, a 
close-up of a scalpel with light glinting o# its surface, or paddles dipping frantically in 
roaring white water. Each grabs the viewer’s attention and helps tell your story.

!e establishing shot sets the scene: an isolated peninsula jutting into the ocean. !e second tells the story:  
a thriving gannet colony.

Shoot plenty of video
Videotape is cheap and expendable. Shoot a whole lot more raw footage than you’ll put 
in your "nal production. Five times as much is not unusual. Giving yourself that latitude 
might help you grab shots you would have missed otherwise.



58
Shooting and Capturing Great Video Assets
LESSON 3

Adhere to the rule of thirds
It’s called the “Rule of !irds” but it’s more like the rule of four intersecting lines. When 
composing your shot, think of your view"nder as being crisscrossed by two horizontal 
and two vertical lines. !e center of interest should fall along those lines or near one of 
the four intersections, not the center of the image.

Consider all those family photos where the subject’s eyes are smack dab in the center of 
the photo. !ose are not examples of good composition.

Another way to follow the rule of thirds is to look around the view"nder as you shoot, 
not just stare at its center. Check the edges to see whether you’re "lling the frame with 
interesting images. Avoid large areas of blank space.

!e rule of thirds: Putting your image’s most important elements along the lines or at their intersections will 
make it more pleasing to the eye.

Keep your shots steady
You want to give viewers the sense that they’re looking through a window or, better yet, 
are there on location. A shaky camera shatters that illusion.

When possible, use a tripod. !e best sticks have $uid heads that enable you to make 
smooth pans or tilts.

If it’s impractical to use a tripod try to "nd some way to stabilize the shot: lean against a 
wall, put your elbows on a table, or place the camcorder on a solid object.
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Follow action
!is might seem obvious, but keep your view"nder on the ball (or sprinter, speeding 
police car, surfer, conveyor belt, and so on). Your viewers’ eyes will want to follow the 
action, so give them what they want.

One ni%y trick is to use directed movement as a pan motivator. !at is, follow a leaf ’s 
progress as it $oats down a stream and then continue your camera motion past the 
leaf—panning—and widen out to show something unexpected: a waterfall, a huge 
industrial complex, or a "sherman.

Use trucking shots
Trucking or dolly shots move with the action. For example: hold the camera at arm’s 
length right behind a toddler as he motors around the house, put the camera in a 
grocery cart as it winds through the aisles, or shoot out the window of a speeding train.

Find unusual angles
Getting your camcorder o# your shoulder, away from eye level, leads to more interesting 
and enjoyable shots. Ground-level shots are great for gamboling lambs or cavorting 
puppies. Shoot up from a low angle and down from a high angle. Shoot through objects 
or people while keeping the focus on your subject.

Lean forward or backward
!e zoom lens can be a crutch. A better way to move in close or away from a subject 
is simply to lean in or out. For example, start by leaning way in with a tight shot of 
someone’s hands as he works on a wood carving; then, while still recording, lean 
way back (perhaps widening your zoom lens as well) to reveal that he is working in a 
sweatshop full of folks hunched over their handiwork.
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Get wide and tight shots
Our eyes work like medium angle lenses. So we tend to shoot video that way. Instead, 
grab wide shots and tight shots of your subjects. If practical, get close to your subject 
to get the tight shot rather than use the zoom lens. Not only does it look better but that 
proximity leads to clearer audio.

Using a wide and a tight shot can create greater interest.

Shoot matched action
Consider a shot from behind a pitcher as he throws a fastball. He releases it, then it 
smacks into the catcher’s glove. Instead of a single shot, grab two shots: a medium shot 
from behind the pitcher showing the pitch and the ball’s $ight toward the catcher, and 
a tight shot of the catcher’s glove. Same concept for an artist: get a wide shot of her 
applying a paint stroke to a canvas, then move in for a close shot of the same action. 
You’ll edit them together to match the action. 

Matched action keeps the story $owing smoothly while helping to illustrate a point.
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Get sequences
Shooting repetitive action in a sequence is another way to tell a story, build interest or 
create suspense. A bowler wipes his hands on a rosin bag, dries them over a blower, 
wipes the ball with a towel, picks the ball up, "xes his gaze on the pins, steps forward, 
swings the ball back, releases it, slides to the foul line, watches the ball’s trajectory, and 
then reacts to the shot. Instead of simply capturing all this in one long shot, piecing 
these actions together in a sequence of edits is much more compelling. You can easily 
combine wide and tight shots, trucking moves, and matched action to turn repetitive 
material into attention-grabbing sequences.

Avoid fast pans and snap zooms
!ese moves fall into MTV and amateur video territory. Few circumstances call for such 
stomach-churning camerawork. In general, it’s best to minimize all pans and zooms. As 
with a shaky camera, they remind viewers that they’re watching TV.

If you do zoom or pan, do it for a purpose: to reveal something, to follow someone’s 
gaze from his or her eyes to the subject of interest, or to continue the $ow of action (as 
in the $oating leaf example earlier). A slow zoom in, with only a minimal change to the 
focal length, can add drama to a sound bite. Again, do it sparingly.

   Keep on rolling along

Don’t let this no-fast-moves admonition force you to stop rolling while you zoom or pan. 
If you see something that warrants a quick close-up shot or you need to suddenly pan to 
grab some possibly $eeting footage, keep rolling. You can always edit around that sudden 
movement later.

If you stop recording to make the pan or zoom or adjust the focus, you might lose some 
or all of whatever it was you were trying so desperately to shoot. You will also miss any 
accompanying natural sound.
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Shoot cutaways
Avoid jump cuts by shooting cutaways. A jump cut is an edit that creates a disconnect in 
the viewer’s mind. A cutaway—literally a shot that cuts away from the current shot—
"xes jump cuts.

Cutaways are common in interviews where you might want to edit together two 10-second 
sound bites from the same person. Doing so would mean the interviewee would look 
like he suddenly moved. To avoid that jump cut—that sudden disconcerting shi%—you 
make a cutaway of the interview. !at could be a wide shot, a hand shot, or a reverse-
angle shot of the interviewer over the interviewee’s shoulder. You then edit in the 
cutaway over the juncture of the two sound bites to cover the jump cut.

!e same holds true for a soccer game. It can be disconcerting simply to cut from one 
wide shot of players on the "eld to another. If you shoot some crowd reactions or the 
scoreboard, you can use those cutaways to cover up what would have been jump cuts.

A crowd reaction shot works well as a cutaway from this bloodless bull"ght in Sumatra

Don’t break the plane
!is avoids another viewer disconnect. If you’re shooting in one direction, you don’t 
want your next shot to be looking back at your previous camera location. For instance, 
if you’re shooting an interview with the camera peering over the le% shoulder of the 
interviewer, you want to shoot your reverse cutaways behind the interviewee and over 
his right shoulder. !at keeps the camera on the same side of the plane—an imaginary 
vertical $at surface running through the interviewer and interviewee.
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To shoot over your interviewee’s le% shoulder would break that plane, meaning the 
viewer would think the camera that took the previous shot should somehow be in view.

Incorrect placement
“breaks the plane”

Interview 
Subject 

Interviewer 

Plane

OK 

Reverse 
cutaway 

!e plane is an imaginary vertical wall running, in this case, through the reporter and interviewee. Breaking 
the plane—particularly when shooting a reverse cutaway—leads to camera shots that cause viewer disconnects.

In general, you want to keep all your camera positions on one side of that plane, even 
when shooting large-scale events like football games. Otherwise viewers may lose track 
of the direction of play

!ere are exceptions. Consider videotaping a rock group performance. Camera 
crewmembers typically scramble all over the stage, grabbing shots from multiple angles, 
and frequently appear on camera themselves.
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   Switch sides
If you conduct formal, sit-down interviews with more than one person for the same 
piece, consider shooting each subject from a di#erent side of the interviewer. Shoot one 
subject with the camera positioned over the le% shoulder of the reporter, and for the next 
interview position the camera over the right shoulder of the reporter. !at avoids a subtle 
jump cut that happens when you edit two bites from two individuals who are both facing 
the same way.

Use lights
Lights add brilliance, dazzle, and depth to otherwise bland and $at scenes. Consider 
using an onboard camcorder "ll light and, if you have the time, money, patience, or 
personnel, a full lighting kit with a few colored gels. In a pinch, do whatever you can to 
increase available light. Open curtains, turn on all the lights, or bring a couple of desk 
lamps into the room. One caveat: Low-light situations can be dramatic, and $ipping on 
a few desk lamps can destroy that mood in a moment.
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Grab good “bites”
Your narrator presents the facts. !e people in your story present the emotions, feelings, 
and opinions. Don’t rely on interview sound bites to tell the who, what, where, when 
and how. Let those bites explain the “why.”

In a corporate backgrounder, have the narrator say what a product does and let the 
employees or customers say how enthusiastic they are about that product.

Your narrator should be the one to say, “It was opening night and this was her "rst solo.” 
Let the singer, who is recalling this dramatic moment, say, “My throat was tight and my 
stomach was tied in knots.”

In general, even though your interviews might take forever, use only short sound bites 
in your "nal production. Use those bites as punctuation marks, not paragraphs.

   Exceptions for idiosyncratic characters

None of these admonitions are carved in stone. Some characters you’ll videotape are so 
compelling, quirky, or humorous that your best bet is to let them be the primary narrator. 
!en you’ll want to consider what scenes you can use to illustrate their commentary. You 
don’t want to "ll your entire video with a “talking head.”

Get plenty of natural sound
!ink beyond images. Sound is tremendously important. Listen for sounds you can use 
in your project. Even if the video quality is mediocre, grab that audio. Your camcorder’s 
onboard mic is not much more than a fallback. Consider using additional mics: shotgun 
mics to narrow the focus of your sound and avoid extraneous noise, lavalieres tucked 
out of sight for interviews, and wireless mics when your camera can’t be close enough to 
get just what you need.
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Stripe your tapes
Premiere Pro can automate much of the video capture process. But if your DV (digital 
video) tape has a gap in its timecode, automated capture might not work.

Gaps typically occur when you eject a partially recorded tape and then reinsert it. !at 
resets the timecode to zero and can leave an unrecorded portion on the tape. Either of 
these means Premiere Pro won’t be able to automatically capture clips you’ve logged.

Striping your tapes before shooting resolves this issue. You can stripe tapes by placing a 
fresh tape in your camcorder, capping your lens, pressing Record, and waiting for your 
camcorder to record the entire tape.

!is lays down a continuous timecode from beginning to end and ensures that there 
will be no duplicate timecodes or breaks in the timecode on the tape.

Rewind the tape and you’re ready to go. Now, as you use your camcorder, it’ll record 
new video over the black video you taped but won’t change the timecode.

Plan your shoot
When you consider a video project, plan what you need to shoot to tell the story. 
Videotaping your kid’s soccer championship match, a corporate backgrounder, or a 
medical procedure each require planning to ensure success. Know what you want your 
"nal video project to say and think of what you need to videotape to tell that story.

Even the best-laid plans and most carefully scripted projects might need some adjusting 
once you start recording in the "eld. No matter how you envision the "nished project, 
be willing to make changes as the situation warrants.
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    Karl Petersen—Chief Photographer, KGW-TV, Portland, OR

A D V I C E  F R O M  A  T V - N E W S  C H I E F  P H O T O G R A P H E R

Karl Petersen is my favorite TV news photographer. We worked together at KSL-TV in Salt 
Lake City and formed a video production company in Oregon called Glint Video (we always 
tried to get a “glint” shot—a little !ash of re!ected light—in all our videos). Karl now is chief 
photographer at KGW-TV in Portland. Here are his tips:

• My "rst shooting advice is, don’t do it. Pursue a career of doctor, lawyer, teamster, stevedore, 
bordello piano player, whatever.

• Having failed that, my next tip is always to shoot as an editor. Always think about how to get 
from one shot to the next. Try to get some kind of transition shot with either an entry or exit. 
Close-ups are especially helpful in editing to get from point A to point B.

• Get a good shot mix—wide, medium, close-up (extreme close-ups work well), and unusual 
angles. Get lots of shots. Variety is an editor’s friend.

• Get an establishing shot that tells viewers where you are.

• Fundamentals: Make sure that you have freshly charged batteries, always monitor audio 
by wearing an earpiece (if you don’t you’re guaranteed to get burned), and watch your color 
balance.

• For all indoor interviews, I recommend using at least two lights. If I’m to the reporter’s right, 
I place a light with an umbrella re!ector slightly to his left. That means the interviewee is 
looking toward the light. I place a light with “barn doors” (to keep it from shining into the lens) 
behind and over the left shoulder of the interview subject (that is, to my right). This adds nice 
highlights. If I have time, I place a third umbrella well behind the camera to add "ll.

• If I’m shooting in a room with sunlight coming in a window, I use blue gels that  are especially 
balanced for daylight, and then color balance for sunlight
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Shooting aerials

If you like to do things on a grander scale you might get the opportunity to shoot from a 
helicopter. When shooting from KGW-TV’s helicopter, “Sky 8,” I sit in the warmth and comfort of 
the back seat and operate the cameras with a laptop and a joystick. Not many video producers 
have this luxury. For those who must shoot from a side window, here are some tips:

• Think safety "rst. Make sure that nothing can fall o# the camera—such as a lens shade—or 
out of the back seat and possibly hit the rotor. That makes the chopper spin like crazy, so you 
get real dizzy before you die.

• Shooting with the door o# is ideal (remove it before you take o#).

• Try to keep the camera slightly inside the doorframe to keep it out of the wind.

• Have the pilot “crab” (!y sort of sideways) so that you can shoot straight ahead. That’s much 
more dramatic. It’s a great way to !y along a river for instance.

• Have the pilot !y low. This allows cool reveal shots, such as !ying over a ridge to reveal an 
expansive vista.

Finally, don’t forget to grab that “glint” shot.

Capturing video
Before you can edit your own video you need to transfer it to your PC’s hard drive. In 
NLE parlance, you need to capture it. Capture is a somewhat-misleading term used 
throughout the NLE world. All that Premiere Pro does during DV capture is to place the 
video data in a Windows AVI "le “wrapper” without changing the original DV data.

!e capture process in the analog world takes several steps: transfer, conversion, 
compression and wrapping. Your camcorder transfers the video and audio as analog 
data to a video capture card. !at card’s built-in hardware converts the waveform signal 
to a digital form, compresses it using a codec (Compression/Decompression) process, 
and then wraps it in the AVI "le format.
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Three DV capturing scenarios
Premiere Pro o#ers tools to take some of the manual labor out of the capturing process. 
!ere are three basic approaches. I’ll take you through all of them:

• Capture your entire videotape as one long clip
• Log clips’ in- and out-points for automated, batch capturing
• Use the scene detection feature in Premiere Pro to automatically create separate clips 
whenever you pressed the pause/record button on your camcorder
To do this and the following mini-lessons, you need a DV camcorder. Most DV 
camcorders have a FireWire (IEEE 1394) cable that you hook up to your PC’s FireWire 
connector. If your PC does not have a FireWire connector, I recommend you buy a 
FireWire/USB combination card. Decent ones cost less than $20.

You can work with HDV (a compressed high de"nition video format) or with a 
professional-level camcorder with an SDI (Serial Digital Interface) connector and a 
specialized video capture card.

Premiere Pro handles HDV and SDI capture with the same kind of so%ware device 
controls used with a standard DV camcorder. SDI requires an extra set-up procedure. 
Refer to Premiere Pro Help for more on that.

If you have an analog camcorder, you need a video capture card that can handle S-Video 
or Composite video connectors. Your only option with most analog camcorders is to 
manually start and stop recording. Most don’t work with remote device control or have 
timecode readout so you cannot log tapes, do batch capture devices and most do not use 
the scene detection feature.

Adobe Certi!ed Expert exam objectives
Completing all the lessons in this book will go a long way toward preparing you for the Adobe 
Certi"ed Expert (ACE) exam for Premiere Pro 2.0. I have included the exam objectives in the P Pro 
ACE Objectives.pdf "le on this book’s companion DVD in the Adobe Certi"ed folder. And I state the 
objectives individually in lessons as they come up. I have also included a collection of sample questions 
in the Adobe Certi"ed folder.

Here is the "rst objective: Describe the process, tools and options Adobe Premiere Pro provides for 
capturing digital video by using device control.
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Capturing an entire tape: Lesson 3-1
1 View the Lesson 3 Intro video.
2 Connect the camcorder to your PC.

3 Turn on your camcorder and set it to the playback mode: VTR or VCR. Do not set 
it to the Camera mode.

Note: Windows might note that you’ve powered up your camcorder by popping up a 
Digital Video Device connection message.

   Use AC, not a battery

When capturing video, use your camcorder’s AC adapter, not its battery. Here’s why: 
When using a battery, camcorders can go into sleep mode. And the battery will o%en run 
out before you’re done.

4 If the Digital Video Device window did pop up, click Take No Action, check the 
Always Perform the Selected Action checkbox and click OK.
Next time you "re up your camcorder, you should not see this connection query.
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   Project settings for SDI or HDV

!is project assumes you are recording from a DV camcorder: standard 4:3 format or 
widescreen anamorphic 16:9 screen ratio. If you are working with SDI or HDV, you need 
to Start Premiere Pro, click New Project and select the preset Project Settings that match 
your camcorder.

5 Start Premiere Pro, click Open Project, navigate to the Lesson3 folder and double-
click Lesson 3-1.prproj.
6 From the Main Menu, select File > Capture to open the Capture panel.

7 Look above the Capture panel preview pane to make sure your camcorder is 
connected properly.
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Note: If a message says No Device Control or Capture Device O&ine, you’ll need to do 
some troubleshooting. !e most obvious "x is to make sure the camcorder is turned on and 
the cables are connected. For more troubleshooting tips refer to the Premiere Pro help "les.

8 Insert a tape into your camcorder. Premiere Pro will prompt you to give the tape a name.
9 Type in a name for your tape in that text box. Be sure not to give any two tapes the 
same name. Premiere Pro remembers clip in/out data based on tape names.

10 Use the VCR-style device controls in the Capture panel to play, fast forward, 
rewind, pause and stop your tape. If you have never used a PC to control a camcorder, 
this will seem pretty cool.

B A C D E F G H I J K 

M L N O P Q R S 

Capture panel playback controls: A. Next scene  B. Set In point  C. Set Out point  D. Rewind E. Step back  
F. Play  G. Step forward  H. Fast forward  I. Pause  J. Stop  K. Record  L. Previous scene  M. Go To In point  
N. Go To Out point  O. Jog  P. Shuttle  Q. Slow reverse  R. Slow play  S. Scene detect

11 Try some of the other VCR-style buttons (if you need help identifying these 
buttons, Tool tips pop up as you hover your cursor over them):
• Shuttle (the slider toward the bottom) enables you to move slowly or zip quickly—
depending on how far you move the slider o# center—forward or backward through 
your tape.
• Single-frame Jog control (below the Shuttle)
• Step Forward and Backward, one frame at a time
• Slow Reverse and Slow Play



ADOBE PREMIERE PRO 2.0 73
Classroom in a Book

12 Rewind the tape to its beginning or to wherever you want to start recording.
13 In the Setup area of the Logging tab note that Audio and Video is the default 
setting. If you want to capture only audio or video, change that setting.

14 Click the Tape button or the Record button to start recording.
You’ll see the video (and hear it) within the Capture panel and on your camcorder.  
Since there is a slight delay during capture, you’ll hear what sounds like an echo. Feel 
free to turn down either your camcorder’s speaker or your PC’s.

15 Click the red Record button or the black Stop button when you want to stop 
recording. !at pops up the Save Captured Clip dialog box.

16 Give your clip a name (add descriptive information if you want) and click OK.
Premiere Pro will store this clip and all other clips you capture during this lesson in 
the Lesson3 "le folder on your hard drive. You can change that to another location by 
selecting Edit > Preferences > Scratch Disks. I cover Preferences in the next lesson.
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Using batch capture and scene detection: Lesson 3-2
When you perform a batch capture, you log the in- and out-points of a number of clips 
and then have Premiere Pro automatically transfer them to your PC.

Use the logging process to critically view your raw footage. You want to look for 
“keeper” video, the best interview sound bites, and any natural sound that will enhance 
your production.

!e purpose of using a batch capture is threefold: to better manage your media assets, 
to speed up the video capture process and to save hard disk space (since one hour of DV 
consumes 13 GB).

Use a clip naming convention
!ink through how you’re going to name your clips. You might end up with dozens of 
clips, and if you don’t give them descriptive names, it’ll slow down editing.

You might use a naming convention for sound bites such as Bite-1, Bite-2, and so forth. 
Adding a brief descriptive comment, such as Bite-1 Laugh, will help.

Here are the steps to follow:

1 In the Capture panel Setup area, click the Logging tab.
2 Change the Handles setting (in lower right corner of the Capture panel) to 30 Frames.
!is adds one second to the start and "nish of each captured clip, which will give you 
enough head and tail frames to add transitions without covering up important elements of 
the clip (and you won’t get that little “Insu&cient Media” message you saw in Lesson 2-3).
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   Using the mouse drag method to change numeric values

When changing the Handles value, you can click on the current number and type in a 
new "gure, or simply place your cursor over the Handles number and drag it le% or right 
to lower or raise the value. !is method of changing a numeric value works throughout 
Premiere Pro.

3 In the Clip Data section, give your tape a unique name.
4 Log your tape by rewinding and then playing it.
When you see the start of a segment you want to transfer to your PC, stop the tape, 
rewind to that spot and click the Set In button.

5 When you get to the end of that segment (you can use Fast-forward or simply Play 
to get there), click Set Out. !e in/out times will display as well as the clip length.

   !ree other ways to set in/out points

!ere are other means to set in-points and out-points for selected clips: click the brackets  
( { or } ) on the play controls, use the keyboard shortcuts—I for In and O for Out—or 
change the in/out time directly in the Timecode area by clicking on the timecode and 
dragging your cursor le% or right.

6 Click Log Clip to open the Clip Data dialog box.
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7 Change the clip name, if needed, add appropriate notes if you want, and then click OK.
!at adds this clip’s name with its in/out times and tape name info to the Project panel 
(with the word “O'ine” next to it). You’ll go there later to do the actual capture.

8 Log clips for the rest of your tape using the same method.
Each time you click Log Clip, Premiere Pro automatically adds a number to the end of 
your previous clip’s name. You can accept or override this automated naming feature.

9 When you’ve completed logging your clips, close the Capture panel.
All your logged clips will be in the Project panel with the word “O'ine” a%er each.

10 Select all the clips in the Project panel that you want to capture (see following Tip 
for three methods to do that).
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   !ree ways to select more than one item

Windows and Premiere Pro o#er three ways to select more than one "le in a window. 
If the "le names are contiguous, mouse-click on the top one and Shi%+click on the last 
one in the group, or click o# to one side and above the top clip and drag down to the 
last one to marquee select a group (I used the marquee select method—creating the gray 
rectangle—in the previous "gure). If the "le names are scattered about, click "rst one and 
then Ctrl+click on each additional one in turn.

11 Select File > Batch Capture.
!at opens a very simple Batch Capture dialog box that allows you  to override the 
camcorder settings or add more handle frames.

12 Leave the Batch Capture boxes unchecked and click OK.
!e Capture panel opens, as does another little dialog box telling you to insert the 
proper tape (in your case, it’s probably still in the camcorder).

13 Insert the tape and click OK.
Premiere Pro now takes control of your camcorder, cues up the tape to the "rst clip and 
transfers that clip and all other clips to your hard drive.

14 When completed, take a look at your Project panel to see the results. O'ine "les 
have become movies.
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Using scene detection
Instead of manually logging in- and out-points, you might want to use the Scene Detect 
feature. Scene Detect analyzes your tape’s Time/Date stamp looking for breaks such as 
those caused when you press the camcorder’s pause button while recording.

When Scene Detect is on and you perform a capture, Premiere Pro automatically 
captures a separate "le at each scene break it detects. Scene Detect works whether you 
are capturing an entire tape or just a section between speci"c in- and out-points.

To turn on Scene Detect, in the Capture panel, do either of the following:

• Click the Scene Detect button below the record button.
• Check the Scene Detect checkbox in the Capture panel.

!en you can either set in- and out-points and click Record, or cue your tape to 
wherever you want to start capturing and click Record. In the latter case, click Stop 
when done.

Your clips will show up in the Project panel. No need to batch capture them—Premiere 
Pro captures each clip “on the $y.” Premiere Pro will name the "rst captured clip by 
putting a 01 a%er the name you put in the Clip Name box and then increment each new 
clip by one.
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Tackling manual analog movie capture
If you need to transfer analog video—consumer-level VHS, SVHS, Hi-8, or 
professional-grade video such as Beta-SP—you need a video capture card with analog 
inputs. Most such cards have consumer-quality composite connectors as well as S-video 
and sometimes top-of-the-line component plugs.

Adobe Certi!ed Expert exam objective
Describe the process required to capture analog video.

Check your card’s documentation for set-up and compatibility issues.

With analog video, you have only one capture option — to do it manually:

1 Open the Capture panel (File > Capture).
2 Use the controls on the camcorder to move the videotape to a point several seconds 
before the frame you want to begin capturing.
3 Press the Play button on the camcorder, then click the red Record button in the 
Capture panel.
4 When your clip has been captured, click the Stop button in the Capture panel and 
on the camcorder. Your clip will show up in the Project panel.



Review
Review questions
1 Why is getting the closing shot so important?
2 If you’re shooting a formal sit-down interview and the camera is positioned 
over the le% shoulder of the interviewer, where should you place the camera for 
reverse cutaways?
3 Why should you stripe your tapes?
4 When you open the Capture panel, you don’t see an image in the video 
monitor and you can’t control your DV camcorder. What could be going on?
5 During the capture process, how do you add extra frames to ensure you have 
enough footage to do transitions?
6 You want to capture a clip for its video plus a portion of that clip for a snippet 
of natural sound. How do you do that?

Review answers
1 Your closing shot is what viewers take away from your video. You want to do 
what you can to make it memorable.
2 Place the camera behind the interview subject and shoot over his right shoulder.
3 Striping your tapes ensures a distinct and uninterrupted timecode.
4 !is could be one of several things: Your camcorder is not turned on (or if 
you’re using a battery, it might be in sleep mode); you have it in Camera mode 
instead of VCR/VTR; or you haven’t inserted your tape.
5 Put a number of frames in the Handles option in the Capture section of the  
Capture panel. 
6 Simply log that entire clip and then go back and log the audio portion.




